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1. About This Document 
This document will attempt to describe, from the user�s perspective, the most commonly used tasks / 
functions for each module of the Cost Savings Calculator application. 

2. Login Dialog 
 
Cost Savings Calculator has built-in security that is activated the first time you log in. When you enter a 
Username and Password this is saved and must be entered the same way each subsequent log on to access 
the data previously entered. 
 
The Login dialog appears as shown below: 

 

3. Main Menu 
The �Main Menu� is the central control point for the Cost Savings Calculator application. All application 
settings and Modules are accessible from here. The main menu can be seen in the following diagram: 

 



Panasonic 
Lighting 

 

 
Panasonic 
Lighting & Ventilation  
5770 Ambler Drive 
Mississauga, ON  L4W 2T3 
Phone: (905) 238-2285 

 
Email: mailto:rli@panasonic.ca 

Web:   www.panasonic.ca 

Page 2 

3.1. File 
The following options are found on the File menu: 

• Print 
o Prints the �Main Menu�. 

• Exit 
o Closes the Cost Savings Calculator application. 

3.2. View 
The following options are found on the View menu: 

• Tool Bar 
o Hides or unhides the Tool Bar across the top of the �Main Menu�. 

• Status Bar 
o Hides or unhides the Status Bar across the bottom of the �Main Menu�. 

• Launch Buttons 
o Hides or unhides the Launch buttons in the center of the �Main Menu�. 

• Show Graphic 
o Enables or disables the displaying of the Panasonic graphic on the right side of the 

�Main Menu�. 
• Always On Top 

o When set the �Main Menu� is always displayed to the front of all other active 
Windows applications. 

• Splash Screen 
o Displays the application Splash Screen (as seen below). 
 

 



Panasonic 
Lighting 

 

 
Panasonic 
Lighting & Ventilation  
5770 Ambler Drive 
Mississauga, ON  L4W 2T3 
Phone: (905) 238-2285 

 
Email: mailto:rli@panasonic.ca 

Web:   www.panasonic.ca 

Page 3 

3.3. Module 
The following options are found on the Module menu: 

• Project Manager 
o Launches the �Project Manager� Module. 

• Survey Input 
o Launches the �Survey Input� Module. 

• Detail Report 
o Launches the �Detail Report� Module. 

• Zone Summary 
o Launches the �Zone Summary� Module. 

• Project Summary 
o Launches the �Project Summary� Module. 

• Quik Calc 
o Launches the �Quik Calc� Module. 

• Import / Export 
o Launches the �Import / Export� Module. 

• Product Manager 
o Launches the Panasonic �Product Manager� Module. 

• Surveyors 
o Launches the �Surveyors� Module. 

3.4. Language 
Loads and sets as the default the Language information for the Language selected. Once a Language 
has been selected it remains as the default Language (even after the application has been closed) until 
another Language is selected as the default. 

3.5. Tools 
The following options are found on the Tools menu: 

• Change Password 
o Allows the user to permanently change the Cost Savings Calculator login password. 

3.6. Help 
The following options are found on the Help menu: 

• About 
o Displays Cost Savings Calculator Author and Version Information. 

• Contents 
o Launches the Cost Savings Calculator Online Help Module. 

4. Main Menu Graphic 
The Main Menu displays a series of cycling graphic images. A series of 5 images are displayed with each 
image appearing for 10 seconds. The graphic images that are used for the display are located in the Cost 
Savings Calculator install directory. The image file names are Picture1.bmp, Picture2.bmp, Picture3.bmp, 
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Picture4.bmp and Picture5.bmp. The �Main Menu� graphic display can be customized by simply replacing 
the default image files with new ones. 

5. Status Bar 
The Status Bar displays information pertaining to the object directly beneath the mouse pointer. Similar to a 
hint, a short message appears in the Status Bar describing to the user the function that will be activated 
upon clicking the object in question. 

6. Printing 
See Printing under the General Help Topic group for details on printing modules. 

7. Project Manager 

7.1. Launching 

To launch the �Project Manager� Module, from the main menu click the  icon or select �Project 
Manager� from the �Module� drop down menu at the top of the main menu. 

7.2. Description 
The �Project Manager� module allows users to maintain information about projects / customers. The 
module is divided into 3 sections, Projects, Zones and Fixtures. A Project is simply a customer. (i.e. 
Holiday Inn). A Zone is an area within the customer site. (i.e. Board Room #1, Main Lobby, 
Restaurant, etc.). A Fixture is one particular fixture within a zone. (i.e. Table Lamps, Wall Lamps, 
Overhead Lighting, etc.). 
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The following is a sample screen: 

 

7.3. Example: Replace Table Lamps in Holiday Inn Guest 
Rooms 

• Create the Project. 

o Click the  button to add a new Project. 
o Enter the Project name (i.e. Holiday Inn) 
o Enter other specific Project information if desired. 

o Click the  button to save your new Project. 
• Create a Zone. 

o Click the  button to add a new Zone. 
o Enter the Zone name (i.e. Guest Rooms) 
o Enter other specific Zone information if desired. 

o Click the  button to save the Zone. 
• Create a Fixture. 

o Click the  button to add a new Fixture. 
o Enter the Fixture name (i.e. Table Lamps) 
o Enter other specific Fixture information if desired. 
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o Click the  button to save the Fixture. 
• Once you have entered all of the customer specific information you may begin to input 

survey/comparison information using the �Survey Input� module. 

7.4. Notes 
The �Project Manager� module is the starting point for creating surveys/comparisons. Users must first 
enter customer specific information through this module before comparisons can be created. 

8. Survey Input 

8.1. Launching 

To launch the �Survey Input� module, from the main menu click the  icon or select �Survey 
Input� from the �Module� drop down menu at the top of the main menu. 

8.2. Description 
The Survey Input Module allows the user to Add/Modify/Delete detailed lighting information. All of 
the information entered through this Module is stored in the Cost Savings Calculator database and 
made available to other Cost Savings Calculator Modules, specifically the algorithms responsible for 
creating the Detail and Zone Summary Reports. Each Survey belongs to a specific Project, Zone and 
Fixture. Therefore, in order to create a new Survey the user must first create at least one Project, Zone 
and Fixture to which the Survey will belong. 
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The following is a sample screen: 

 

8.3. Usage 
The �Survey Input� module allows users to input customer and Panasonic lamp information for the 
creation of Comparisons. Once the Comparison information has been entered, the results can be 
viewed through the �Detail Report�, �Zone Summary� or �Project Summary� modules. 

8.4. Example: Creating a Comparison 
• Select the Project, Zone and Fixture from the drop down boxes at the top of the module for the 

Fixture you wish to create a Comparison for. 

• Click the  button in the top right of the �Survey Input� module to create a new comparison. 
• Enter a Comparison Name. 
• Select a Surveyor from the drop down list. 
• Enter other general Comparison information if desired. 
• If you entered lamp details/specifics using the �Project Manager� module that information should 

be automatically filled in for you. If not, then enter the existing lamp details. 
• Select a Panasonic product from the Panasonic Fixture drop down box. 
• Enter the Panasonic �# of Lamps�, �Cost/Lamp� and �Cost/Accessory� 
• If you entered Panasonic product details through the �Product Manager� module that information 

should be filled in for you. If not, enter the remainder of the Panasonic lamp information. 

• Click the  button to save the Comparison information. 
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• You may now view the Comparison results through the Cost Savings Calculator �Detail Report�, 
�Zone Summary� or �Project Summary� modules. 

8.5. Notes 
If the drop down boxes for Project and/or Zone and/or Fixture at the top of the �Survey Input� module 
are empty, ensure that you have created the required Project/Customer information using the �Project 
Manager� module. 

9. Detail Report 

9.1. Launching 

To launch the �Detail Report�, from the main menu click the  icon or select �Detail Report� from 
the �Module� drop down menu at the top of the main menu. 

9.2. Description 
Cost Savings Calculator users have the ability to generate Detail Reports summarizing Fixture 
information and showing cost savings. The Reports are generated using the information users input 
through the Survey Input Module. Reports can be generated by launching the Report Module from the 
Main Menu.  
 
All calculations required to generate the Survey Reports are performed each time the Module is 
accessed (i.e. The reports are not saved to disk but recreated on the fly). 
 
The following is a sample screen: 

 

9.3. Usage 
The �Detail Report� provides a detailed description of the cost savings that will be recognized by 
choosing one lamp over another. Select the Project, Zone, Fixture and Comparison that you wish to 
view in the �Detail Report�. You must have already your customer specific information through the 
�Project Manager� module and your comparison information through the �Survey Input� module. 
Once the �Detail Report� is displayed you can access functions like Print and Exit by using the right 
mouse button and selecting from the popup menu. 
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10. Zone Summary 

10.1. Launching 

To launch the �Zone Summary� module, from the main menu click the  icon or select �Zone 
Summary� from the �Module� drop down menu at the top of the main menu. 

10.2. Description 
This Module summarizes savings by Project and Zone. The information entered through the Survey 
Input Module is used to generate the summary information. Each Existing and Panasonic Fixture 
within a Project and Zone along with a graphic image for each are displayed when available. Three (3) 
comparisons along with summary information are displayed per page. Scroll bars allow the user to 
page forwards and backwards if more than three (3) Surveys exist for the selected Project and Zone. 
 
The following is a sample screen: 

 

10.3. Usage 
The �Zone Summary� module allows users to summarize cost savings by zone or area. You must have 
already entered Project/Customer details through the �Project Manager� module and Comparison 
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information through the �Survey Input� module. Select the desired Project and Zone from the drop 
down boxes at the top of the module. Summary information will be displayed automatically.  

You can print the �Zone Summary� results by clicking the print button  on the tool bar. 

10.4. Notes 
If the drop down boxes for Project and/or Zone are empty ensure that you have entered the required 
Project/Customer information through the �Project Manager� module. If after selecting a valid Project 
and Zone summary information is not displayed, ensure that you have entered the required Comparison 
information through the �Survey Input� module. 

11. Project Summary 

11.1. Launching 

To launch the Project Summary Module, from the main menu click the  icon or select �Project 
Summary� from the �Module� drop down at the top of the main menu. 

11.2. Description 
This Module summarizes savings by Project. The user is able to select the specific Surveys within a 
project that will be used to generate the summary information. For each survey selected Existing and 
Panasonic Fixture information is displayed. Up to 10 surveys will be displayed per page. The summary 
information for the selected Surveys is displayed at the bottom of the module. Scroll bars allow the 
user to page forwards and backwards if more than three (10) Surveys were selected. 
 



Panasonic 
Lighting 

 

 
Panasonic 
Lighting & Ventilation  
5770 Ambler Drive 
Mississauga, ON  L4W 2T3 
Phone: (905) 238-2285 

 
Email: mailto:rli@panasonic.ca 

Web:   www.panasonic.ca 

Page 11 

The following is a sample screen: 

 

11.3. Usage 
• The �Project Summary� module allows users to summarize cost savings by allowing them to 

select various Comparisons for different Projects and Zones and combine them into a single 
report. 

• In the �Project Summary� selection screen highlight, in the top section of the screen, the 
Comparisons to include in the summary. 

• If you hold the shift key down when selecting Comparisons you can highlight multiple 
Comparisons at once. 

• Click the  button to add the highlighted Comparisons to the list of Comparisons to be included 
in the �Project Summary� report. 

• Once you have selected the Comparisons that you wish to summarize click the  
button to view the �Project Summary� report. 

• The report can be printed by clicking the print button  from the tool bar. 
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11.4. Notes 
If there are no Comparisons to select from in the �Project Summary� selection screen, ensure that you 
have entered the required Project/Customer information through the �Project Manager� module and the 
required Comparison information through the �Survey Input� module. 

12. Quik Calc 

12.1. Launching 

To launch the �Quik Calc� Module, from the main menu click the  icon or select �Quik Calc� from 
the �Module� drop down menu at the top of the main menu. 

12.2. Description 
The Quik Calc Module provides the user with a quick means of inputting Survey Information for 
comparison. The information input within the Quik Calc Module is not stored within the Cost Savings 
Calculator database and is only retained until the Quik Calc Module is closed. Users wishing to save 
their Survey information must use the Survey Input Module. As the user inputs information, the 
information is validated and used to populate calculated fields with the Module. 
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The following is a sample screen: 

 

12.3. Usage 
The �Quik Calc� module allows users to quickly create comparisons without having to enter other 
customer specific information for Projects, Zones, etc. The comparisons created with this module are 
not saved and will be lost once the module or application is closed. Some of the required input fields 
will be automatically populated as you type. Once all of the required information is entered the 
comparison results will be displayed at the bottom.  

The comparison information can be printed by pressing the Print button  on the tool bar. 

13. Import / Export 

13.1. Launching 

To launch the �Import / Export� module, from the main menu click the  icon or select �Import / 
Export� from the �Module� drop down menu at the top of the main menu. 
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13.2. Description 
The �Import / Export� module allows users to export and/or import Cost Savings Calculator 
information so that it can be shared with other Cost Savings Calculator users. It can also be used to 
backup/save Cost Savings Calculator information. Imports and exports can be full or partial. Selecting 
full will import or export all Cost Savings Calculator information. Selecting partial will allow you to 
import or export specific Cost Savings Calculator information like product data or language 
information. 
 
The following is a sample screen: 

 

13.3. Example: �Exporting Language Information� 
• Click the  Export radio button. 
• Click the  Partial radio button. 
• Click the  Languages check box. 

o This will export all languages. 
o If you wish to export a single language select the desired language from the �Languages� 

drop down box. 

• Click the  button. 
• Enter a filename for the export file. 

o The default directory for all export files is <Install Dir>\export, where <Install Dir> is 
usually �C:\Program Files\Panasonic\Cost Savings Calculator�. 

o You only need to enter the file name. The default file extension �.exp� will automatically 
be appended to the filename that you enter. 

• Click the  button. 
• When the export is complete you will be notified. 
• The export file can be sent to another user where he/she can import it into their version of Cost 

Savings Calculator. 
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13.4. Notes 
A full export will make a complete copy of all Cost Savings Calculator information including language 
data, customer data and product information. The export file for a full backup can be saved to disk or 
tape or copied to another machine on the network for safekeeping. 

14. Language Manager 

14.1. Launching 
Access to the �Language Manager� module is restricted to system administrators. Please contact a 
system administrator if you need access to this module. 

14.2. Description 
The �Language Manager� module allows administrators to customize the Cost Savings Calculator user 
interface by allowing them to add new languages to the system and / or modify and maintain various 
versions of existing language (i.e. French Quebec, French France). All text displayed in all modules of 
the Cost Savings Calculator application, including error messages, can be customized using the 
�Language Manager� module. 

14.3. Example: �Adding a New Language� 
• Click the  button to add a new language. 
• Fill in the �Language Name�. 

o The �Language Name� is an internal name only. 
o It will not be seen by the users. 

• Fill in the �Display Name�. 
o The �Display Name� will be the name that the users will see. It is the name that will 

appear in the list of available languages when the user selects his/her preferred language 
from the main menu. 

• Select �Enable Language� if you would like the new language to available immediately. If you do 
not enable it, it will not appear in the list of available languages from the main menu. 

• Select �Set as Default Language� if you would like the new language to be the default language. 
The default language will be the one that is loaded each time the application starts. 

• Click the  button to create your new language. 
• Creating new captions. 

o Captions represent the actual textual elements that are displayed with the Cost Savings 
Calculator application. (e.g. field headings, window titles, error messages, etc.) 

o When creating the captions for your new language you can either start with blank 
captions or copy the caption text from an existing language. It is recommended that you 
copy from an existing language as this will give you a better idea of how each of the 
captions are being used. 

o Select the �Copy Captions From� radio button. 
o Select the language that you wish to copy from, from the drop down list. 

o Click the  button. 
• Modifying new captions. 

o The lower half of the �Language Manager� module will now display your new captions. 
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o Captions are organized by module. You will work with one module at a time by selecting 
the desired module from the �Modules� drop down list. 

o You can make your changes to the captions by editing right in the grid. 
o Once you have modified a particular caption use the up or down arrow key or press the 

 button to save your change. 
• Once you have made all the necessary modifications to the language captions you can go back and 

set your new language as the default in order to verify your changes. 
o Click the  Set as Default Language check box. 

o Click the  button to save your changes. 

14.4. Notes 
The English (Base) Language is shipped with Cost Savings Calculator and cannot be modified or 
deleted. If you wish to make changes to the English (Base) language take a copy of it and modify and 
activate the copy. It is recommended that you not set the language as the default until after you have 
finished updating the language text items. 

15. Product Manager 

15.1. Launching 

To launch the �Product Manager� module, from the main menu click the  icon or select �Product 
Manager� from the �Module� drop down menu at the top of the main menu. 

15.2. Description 
The Product Manager Module allows users to Add/Edit/Delete Panasonic Product data. Users may 
import or export Panasonic Product data using the Import/Export Module. 
 



Panasonic 
Lighting 

 

 
Panasonic 
Lighting & Ventilation  
5770 Ambler Drive 
Mississauga, ON  L4W 2T3 
Phone: (905) 238-2285 

 
Email: mailto:rli@panasonic.ca 

Web:   www.panasonic.ca 

Page 17 

The following is a sample screen: 

 

15.3. Usage 
The �Product Manager� module allows users to maintain information about Panasonic lamps. 

15.4. Example: Adding a Product 
• Click the  button in the upper right corner of the module to add a new product. 
• Enter the Panasonic product name. 
• Enter other product specific information if desired. 

• To select an image for the new product click the  button. 
• Navigate to find the desired image file. 
• Windows BITMAP and JPEG file formats are supported for image files. 

• Once you have found the desired image file click the  button and the image should 
be displayed. 

o Double clicking on an image displays an enlarged version of the image. 

• Click the  button to save your new product. 
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15.5. Notes 
The only mandatory piece of information when adding a product is the product name, although 
entering product details will save you time when creating comparisons as you won�t have to reenter 
Panasonic product specifics each time you use the product in a comparison. To import new Panasonic 
data or to export product data so that it can be shared with other Cost Savings Calculator users or saved 
as a backup use the Cost Savings Calculator �Import/Export� module. 

16. Surveyors 

16.1. Launching 
To launch the �Surveyors� module, select �Surveyors� from the �Module� drop down menu at the top 
of the main menu. 

16.2. Description 
The Surveyor Module allows users to Add/Edit/Delete Surveyor information. 
 
The following is a sample screen: 

 

16.3. Usage 
The �Surveyors� module allows users to maintain a list of Surveyors. The �Survey Input� module 
makes use of Surveyors to track who the Comparisons are being created by. This is particularly useful 
when consolidating Comparison information from several Cost Savings Calculator systems into one. 
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16.4. Example: Add a Surveyor 
• Click the  button to add a surveyor. 
• Enter the Surveyor name. 
• Enter other Surveyor specific information if desired. 

• Click the  button to save the new Surveyor. 

16.5. Notes 
You must have at least one Surveyor in the system. 

17. General 

17.1. Buttons 
• The  button will display product author and version information. 

• The  button will close the currently active module. 

• The  button will print the current module. 

• The  button will launch the on-line help module. 

• The same four buttons  are displayed in several of the Cost Savings Calculator 
modules. 

o The  button represents the add action. 

o The  button represents the delete action. 

o The  button represents the save action. 

o The  button represents the cancel action. 

o By default the  and  buttons are always active. 

o By default the  and  buttons are only active if something has been modified. 
o A button is considered to be inactive if it is greyed out. 

17.2. Images 
To change the cycling images on the �Main Menu� replace the 5 image files named picture1.bmp 
through picture5.bmp (found in the Cost Savings Calculator install directory) with your own Windows 
BITMAP images. To change the splash screen image replace the image file splash.bmp (found in the 
Cost Savings Calculator install directory) with your own Windows BITMAP image. Double clicking 
images in most modules will bring up an enlarged view of the image. 

17.3. Printing 
Every module within the Cost Savings Calculator application can be printed by clicking the  
button on the tool bar. 
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In addition to being able to print to printer, users can print to the Windows clipboard or to a file. 
Screen images can then be pasted into documents or included in email messages.  

The following is a sample of this dialog box: 

 

17.4. Version Information 
Each version of Cost Savings Calculator contains specific version information. Version information is 
important when diagnosing application problems. The version information can be displayed by 
clicking the About Button on the Toolbar at the top of each Module or selecting Help-About from the 
main menu. The following version information is maintained for each version of Cost Savings 
Calculator: 

o Author 
o Release Date 
o Version Number 

17.5. Online Help 
Each Module within the Cost Savings Calculator application contains Online Help. The Online Help 
Module can be activated by clicking the Help Button, which resides on the Toolbar at the top of each 
Module or by pressing the �F1� key. The Online Help is context sensitive at the Module level. The 
user is responsible for navigating through the Online Help to find information on specific items within 
a Module. 
 
Note: The Online Help Module is available in English only. Panasonic is responsible for translating 
and/or providing Help in other Languages. 

17.6. Units of Measure 
Various data input fields and output display fields have their Units of Measure Caption displayed to the 
right of the field. The Units of Measure like other text displayed within Cost Savings Calculator are 
represented as Language Text Items. Each Unit of Measure has a different Text representation in each 
Language. The calculations performed (algorithms) in creating reports, summary information, etc 
remains constant within Cost Savings Calculator regardless of the Language selected or the Unit of 
Measure. The calculations do not change based on the selected Language and/or Unit of Measure.  

17.7. Data Formatting 
The formatting of data within the data input fields and the output display fields remains constant within 
Cost Savings Calculator regardless of the Language selected. The formatting of Input data and output 
display data does not change based on the selected Language.  
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17.8. Error Messages 
All error messages within Cost Savings Calculator are handled the same as Text Items. Each Error 
Message has a different text representation in each Language. To change the text of a particular error 
message use the Language Manager Module. 

17.9. Currency Symbol 
Where possible Cost Savings Calculator uses the Windows default currency symbol. 

17.10. Currency Formatting 
Where possible Cost Savings Calculator uses the Windows default settings for decimal places and 
thousands separator. 

17.11. Security 
The Cost Savings Calculator application is password protected. The Cost Savings Calculator 
application is delivered with a blank password. To change your password select �Change Password� 
from the tools menu off of the Cost Savings Calculator �Main Menu�. 

17.12. Trouble Shooting 
If you are having trouble running the Cost Savings Calculator application check the following settings. 

17.12.1. Registry 
The Cost Savings Calculator install program creates a registry entry. Ensure that it exists. 
• HKEY_LOCAL_MACHINE\\SOFTWARE\Cost Savings Calculator2000 

o DefDir = <Install Dir> 

17.12.2. BDE 
• Cost Savings Calculator installs the Borland Database Engine. 
• Start the BDE Administrator from the Windows Control Panel. 
• Under the �Databases� tab there should be 2 entries. 

o Cost Savings Calculator2000 
• Should point to <Install Dir>\database. 

o Cost Savings Calculator2000IE 
• Should point to <Install Dir>\database\temp. 

 


